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Disclaimer

1. DISCLAIMER

The information in this document is subject to change without notice and does not represent a
commitment on the part of Native Instruments GmbH. The software described by this document is
subject to a License Agreement and may not be copied to other media. No part of this publication
may be copied, reproduced or otherwise transmitted or recorded, for any purpose, without prior
written permission by Native Instruments GmbH, hereinafter referred to as Native Instruments.

“Native Instruments”, “NI” and associated logos are (registered) trademarks of Native Instruments
GmbH.

Mac, macOS, GarageBand, Logic and iTunes are registered trademarks of Apple Inc., registered
in the U.S. and other countries.

Windows and DirectSound are registered trademarks of Microsoft Corporation in the United States
and/or other countries.

All other trademarks are the property of their respective owners and use of them does not imply
any affiliation with or endorsement by them.

Document authored by: Adam Hanley, Jan Ola Korte

Software version: REAKTOR 6.4 (07/2020)
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What Is New in REAKTOR 6

2. WHAT IS NEW IN REAKTOR 6

In this document, REAKTOR users can learn about the new features and improvements that have
been added to REAKTOR 6 and subsequent versions, including references to the corresponding
manuals in the REAKTOR 6 documentation. For new REAKTOR users, it is suggested to start with
the REAKTOR 6 Getting Started document.
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The REAKTOR 6 Documentation

3. THE REAKTOR 6 DOCUMENTATION

The documentation for REAKTOR 6 is divided into separate documents, guiding you from loading
and playing pre-built Ensembles to building your own Instruments.

REAKTOR 6 What Is New: For users who are already familiar with previous versions of RE-
AKTOR and only describes the latest features in brief.

REAKTOR 6 Getting Started: For new users, and the only document needed for users who
want to load and play pre-built REAKTOR instruments and effects.

REAKTOR 6 Diving Deeper: For intermediate users, expands on the concepts introduced in
the Getting Started document, and introduces advanced topics like OSC control and combining
multiple Instruments.

REAKTOR Blocks Quick Start Guide: For new Blocks users, an online resource showing you
how to use REAKTOR Blocks in the Rack format. Find it here: www.native-instruments.com/
reaktor-blocks-quickstart

REAKTOR Blocks Manual: For all Blocks users, includes comprehensive information about all
workflows and features related to patching with Blocks in Racks and Ensembles.

REAKTOR 6 Building in Primary: For advanced users, explains how to build your own Instru-
ments in REAKTOR’s Primary level based on a series of tutorials.

REAKTOR 6 Building in Core: For advanced users, describes the Core level of REAKTOR
with its low-level building features, which can be used for implementing custom DSP algo-
rithms.

While it is not necessary to read all of the documentation, some of the more ad-
vanced documents assume knowledge from previous documents.
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REAKTOR 6.4

4. REAKTOR 6.4

The following new features and changes have been added to REAKTOR 6.4.

User Blocks in Racks

You can now use User Blocks in Racks, including Blocks downloaded from the REAKTOR User
Library, or your own creations. The following functionality has been implement to facilitate this:

« Users of the full version of REAKTOR 6 can load User Blocks into Racks.

» Users of REAKTOR 6 Player can load User Blocks into Racks, however User Blocks will run in
Demo mode and be muted after 30 minutes.

» User Blocks are stored in the Rack file with a reference to their file path. Missing User Blocks
are displayed when loading a Rack and can be relocated.

» The User Block directory enables sharing of Racks between users. User Blocks located in the
same relative path within the User Blocks directory are automatically detected when loading a
Rack.

» User Blocks located in the User Block directory are accessible directly in the Library tab of the
REAKTOR Browser, and can be found using the search box in a Rack.

* The location of the User Blocks directory can be changed in the Preferences.

Information about User Racks can be found in the REAKTOR Blocks Manual docu-
ment.

Updated Blocks documentation

The documentation about Blocks has been updated and expanded in the new REAKTOR Blocks
Manual document. It includes extensive information about workflows and features related to
patching with Blocks in Racks and Ensembles, as well as comprehensive reference sections de-
tailing all possible connections, signals, and controls.

You can download the REAKTOR Blocks Manual document here: hitps://
www.native-instruments.com/products/komplete/synths/reaktor-6/downloads/
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5. REAKTOR 6.3

The following new features and changes have been added to REAKTOR 6.3.

REAKTOR Racks

You can now patch with REAKTOR Blocks in the new Rack format. Racks facilitate analog-style
modular synthesizer patching. In a Rack, you can arrange, connect, and control Blocks directly in
the Panel. The patch is also mirrored in the Structure, allowing you to choose your preferred
patching workflow. All settings including the arrangement of Blocks and the connections made be-
tween them are saved and recalled with your host sequencer project (host chunk saving).

Information about Racks can be found in the REAKTOR 6 Patching with Blocks
document. If you are new to Blocks, you can learn how to patch using the Quick
Start Guide: https://www.native-instruments.com/reaktor-blocks-quickstart/

Panel Ports

Ports of Instruments and Macros can now be made visible and used on the panel. This way you
can add modular-style patching to your Instrument.

Information about Panel Ports can be found in the REAKTOR 6 Building in Pri-
mary document.

Switching Views for Multiple Instruments

You can now switch between the A and B view of all Instruments contained in an Ensemble at the
same time. This is useful for switching between views with and without Ports on the panel, for ex-
ample.

Information about switching views can be found in the REAKTOR 6 Building in Pri-
mary document.

Borders

The borders at the edges of an Instrument panel can now be adjusted. This way you can define
how close panel elements can be placed to the edges.
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@ Information about Instrument borders can be found in the REAKTOR 6 Building in
Primary document.
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REAKTOR 6.2.2

6. REAKTOR 6.2.2

The following new features and changes have been added to REAKTOR 6.2.2.

Core Macro Library Updates

The Core Macro Library has received significant updates, including new filters, phaser, flanger,
overdrive, bit and sample reduction effects, a compressor, synced LFOs, and the LFO toolkit.

Information about the Core Macro Library can be found in the REAKTOR 6 Building
in Core document.
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REAKTOR 6.2

7. REAKTOR 6.2

The following new features and changes have been added to REAKTOR 6.2.

7.1. Overview

Content Protection

+ Protected Content by third-party developers and Native Instruments.

+ Structure locking for official content products.

» Sample protection for official content products.

» Player tab sorts products by vendor.

» Demo screen can display multiple products (instruments) and their demo time.
» Native Access activation callback implemented in REAKTOR.

In addition to the linked section, information about protected content can be found in
the REAKTOR 6 Getting Started document.

General Updates

» Fixed: Enabling [caps lock] prevents deletion of modules with [delete] key.

» Fixed: Deleting one character in search box deletes whole unmarked word.

» Fixed: No MIDI input from computer keyboard after renaming a bookmark.

» Fixed: Performance regression when using Resynth, Graincloud and Pitchformer Modules.
» Fixed: Drag & drop of Primary Module files into Structure.

7.2. Protected Content

REAKTOR 6.2 adds the option to protect official content products by third-party developers and
Native Instruments. This means that the Structure of the Ensemble — or Instrument in the case of a
protected module for REAKTOR Blocks — cannot be accessed by the user.

If you are a developer and want to contact Native Instruments about your content
products, please use the email address provided on the following website: https://
www.native-instruments.com/en/specials/komplete/developer/
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@ Information about protected content can be found in the REAKTOR 6 Getting Star-
ted document.
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8. REAKTOR 6.1

The following new features and changes have been added to REAKTOR 6.1.

Synchronization using Ableton Link

REAKTOR 6.1 adds Ableton Link to its set of synchronization features, complementing MIDI Clock
and OSC Sync.

Ableton Link is a protocol that synchronizes beat, phase and tempo of Link-enabled applications
on the same computer or over a shared network. This means you can conveniently keep applica-
tions synchronized across different devices or join a group jam with others with minimal setup.
Connecting applications via Link provides you with the ability to synchronize them to a shared
timeline and change the tempo globally from each of the connected applications.

Information about Ableton Link can be found in the REAKTOR 6 Getting Started
document.
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9. REAKTOR 6.0.3

The following new features and changes have been added to REAKTOR 6.0.3.

9.1. Overview

Updates to the Side Pane

» Presets and Snapshots are both accessible in the updated Presets and Snapshots Tab
+ Ensemble Bank Path for Presets can be edited via the Ensemble Properties

» The Side Pane is resizable

» Keyboard navigation/editing of properties has been improved

+ Certain options in the Properties tabs have been updated to Radio Buttons

@ In addition to the linked sections, information about the Side Pane can be found in
the REAKTOR 6 Getting Started and Diving Deeper documents.

Updates to Panel Editing

* Panel Element Grouping
* Panel Element Layering

» Entering the Structure View via the panel has been changed to [Ctrl] + [Shift] + double-click for
Windows, or [Cmd] + [Shift] + double-click for OS X.

+ Updated Borders Property
* GUI Core Cell

@ In addition to the linked sections, information about panel editing can be found in the
REAKTOR 6 Diving Deeper document.

New and Updated Modules

* Anti-Alias Line Objects for Multi Display and Poly Display
+ System Info Updates
+ Structure Comment Module

@ In addition to the linked sections, information about Modules can be found in the RE-
AKTOR 6 Building in Primary document.
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General Updates

» Usage Data Tracking

9.2. Updates to the Side Pane

9.2.1. Presets and Snapshots Tab

With REAKTOR 6.0.3, Presets have been integrated into what was formerly the Snapshots tab of
the Side Pane. This makes them easier to browse and access when you have an Ensemble open
in REAKTOR.

K3 Embedded

The New Presets Browser

For those familiar with the Snapshots tab, the new Preset Browser should be easy to understand,
as it follows the same paradigm.

One major change, besides the inclusion of Presets, is that the Edit menu has been removed.
Functions from the Edit menu are now contained in a context menu accessed by right-clicking on a
Snapshot or Snapshot Bank.

For more information on the Presets Browser, refer to the Snapshots and Presets chapter of the
REAKTOR 6 Getting Started document.

9.2.2. Ensemble Bank Path

User Presets for Ensembles are located in the following directories:

 On Windows: C:\Users\<User>\Documents\Native Instruments\User Content\Reaktor\<Bank
Name>\

* On OS X: Macintosh HD:\Users\<User>\Documents\Native Instruments\User Content\Reaktor
\<Bank Name>\
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The Bank Name defines the folder into which Presets will be saved, and also the name that will
appear in the KOMPLETE KONTROL and MASCHINE browsers. By default this will be the En-
semble name, but you can change that if you wish.

To change the Bank name:

Select the Ensemble and open the Properties tab.
Navigate to the Function sub-tab.

Scroll to the area called BANKPATH.

Enter the name you wish to use in the Bank property.

R

Select Master Calc-U-Synth VR =

Sub-Bank

The Bank name will be used as Preset folder name, and the Bank name in the KOMPLETE KON-
TROL and MASCHINE Browsers.

9.3. Updates to Panel Editing

9.3.1. Panel Element Grouping

In previous versions of REAKTOR, if you wanted to move the Panel Elements contained within a
Macro as one, you would have to click and drag on the Macro frame. This was fine for some cir-
cumstances, but if the Macro frame was not being used, it required an awkward shifting back and
forth between a hidden and unhidden frame.

A new option has been added to all Macros: Group Panel Elements, located in the VISIBLE sec-
tion of the View tab, allows you to group the Panel elements within a Macro and move them to-
gether as one.

Function Info = View

A B AB

Group Panel Elements Property

When Group Panel Elements is active, you can move all Panel elements contained within the
Macro by clicking and dragging only one of the elements on the Panel. This is especially useful for
layered elements or elements that should be treated as one thing (for example, the modulatable
knobs in the REAKTOR BLOCKS framework).
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For more information on grouping Panel Elements, refer to the Creating and Customizing Interfa-
ces chapter in the REAKTOR 6 Building in Primary documentation.

9.3.2. Panel Element Layering

A property has been added to the View tab of every Panel Element: Layer, located in the VISIBLE
section, allows you to define how Panel Elements are layered within a Macro.

Function Info = View

The Layer Property of a Knob

While you can still define how Panel Elements are layered by using Macros and sub-Macros, the
Layer property allows you to assign an Element to one of 7 layers (0 to 6) within a Macro.

+ Layer O is the lowest layer, with all other layers being placed on top of it.
» Layer 6 is the top layer, with all other layers being placed below it.

Panel Elements that are in the same layer will be ordered as in previous versions of REAKTOR,
with the selected Element being placed on top of the others.

For more information on layering Panel Elements, refer to the Creating and Customizing Interfa-
ces chapter in the REAKTOR 6 Building in Primary documentation.

9.3.3. Updated Borders Property

In previous versions of REAKTOR, the borders of Macros and Instruments had a fixed minimum,
which users were unable to edit. This meant that Panel elements could never be placed at the very
edge of the interface, even if the borders properties were set to zero.

In REAKTOR 6.0.3, this minimum has been removed and it is now possible to move Panel ele-
ments to the absolute edge of a Macro or Instrument.

9.3.4. GUI Core Cell

REAKTOR uses two threads to process signals: the Audio Thread and the GUI Thread.

While all Audio Signals and all Audio Modules are processed in the Audio Thread, some Event
processes will use the Audio Thread and others will use the GUI Thread. This depends on the
source of the signal:

» Events generated from mouse and keyboard interaction will be processed by the GUI Thread.
» Events generated by the Display Clock will be processed by the GUI Thread.
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+ Events generated from the Control Rate Clock (e.g. the LFO Module) will be processed in the
Audio Thread.

» Events generated from control sources outside REAKTOR (i.e. MIDI, OSC, and Host Automa-
tion) will be processed in the Audio Thread.

For example, the following structure will all be processed in the GUI Thread, as the triggering
Event is from the Display Clock:
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An Example of a Structure that will be processed in the GUI Thread

The next example, although functionally very similar, will all be processed in the Audio Thread, as
the Events from the ClockOscillator Module are generated in the Audio Thread:
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An Example of a Structure that will be processed in the Audio Thread

While the Primary level of REAKTOR can deal with these two threads simultaneously, Core Cells
will only process one of these threads at a time.

Since a Core Cell must always be ready to receive signals from either thread, it manages this by
“locking” its inputs while it processes an Event. If the Core Cell receives an Event from the Audio
Thread, it will start to process that Event; if it then receives an Event from the GUI Thread before it
has finished the audio process, it will lock the GUI Thread until the audio process has finished.
This lock is a global lock, so it will affect everything trying to use the locked thread in the Ensemble
structure.

Generally this is not a problem, as modern CPUs can process the Core Cell structures fast enough
so that a user would not notice; however, in some very CPU heavy structures this can lead to low
frame rates and/or audio dropouts as one thread stops the other for too long.

To combat this REAKTOR 6.0.3 has introduced the GUI Core Cell, which only processes Events
from the GUI Thread and ignores all others. It will never lock the Audio Thread, as it has no inter-
action with that thread.

Using GUI Core Cells leads to better performance if you have a particularly complex GUI process
in your structure. A common example being a display that uses a high number of iterations to drive
a MultiDisplay Module.
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Creating a GUI Core Cell

To create a GUI Core Cell:

Create a Core Cell as normal.
Enter the structure of the Core Cell.

When in the Core Cell’s structure, click on an empty space in it to select the Core level prop-
erties.
4. Inthe Function tab of the Core Cell’s Properties, check the GUI Event-Only option.
Core Cell

Function Info

SIGNAL TYPE
FP Precision

Default @

FUNCTION

G Event

You have now created a GUI Core Cell.

A
b
Core Cell H

A GUI Core Cell

Notes on Valid GUI Signals

The following signals will be accepted and processed by the GUI Core Cell:

» Events from Panel Elements as long as they were generated by mouse or QWERTY keyboard
interaction.

» Events generated by the DCIk (display clock) output of the System Info Module.

» Events from Event processing Modules, as long as the triggering Event came from the GUI
Thread (for example, an lteration Module driven by the display clock)

+ Some MIDI Events generated by REAKTOR (see the next sub-section for more information).

The following signals will be ignored by the GUI Core Cell:

 All Audio signals. Audio In Ports in the GUI Core Cell are disabled and marked in red.
» MIDI Events generated from MIDI controllers, external programs, or DAWSs.

OSC Events.

» Events from Panel Elements generated by automation, MIDI, or OSC control.

» Events from Modules that use the Control Rate Clock (e.g. the LFO Module)

» Events from any Event processing Module if the triggering Event came from the Audio Thread.
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Other cases:

» IC (Internal Connection) signals are essentially like wires, so an Event from an IC Module will
be the same as the Event that triggered it.

» Clock signals from the Standard Distribution Buses (i.e. the Sample Rate Clock) are not valid in
GUI Core Cells and will display an error if you try to use them.

Notes on MIDI

As listed in the previous section, a GUI Core Cell will sometimes be able to process MIDI, depend-
ing on the source of the MIDI event.

As a general rule, MIDI events generated by devices and programs other than REAKTOR will al-
ways be processed in the Audio Thread. MIDI events generated inside REAKTOR depend on the
source of the MIDI:

+ The QWERTY keyboard does not natively send MIDI, so REAKTOR takes the keyboard sig-
nals in the GUI Thread, and then generates a MIDI message in the GUI Thread; therefore any
MIDI from the QWERTY keyboard is processed in the GUI Thread.

* If a MIDI output Module receives its Events from a GUI Module, or a Panel Element that is be-
ing controlled with the mouse, then the MIDI signal will be part of the GUI Thread.

As long as the MIDI signal is inside REAKTOR (for example, MIDI connections between Instru-
ments within an Ensemble) the MIDI will remain in the thread from which it was generated.

This information is important as sometimes you may make a GUI Core Cell that is accepting MIDI,
test it on your machine using the QWERTY keyboard and find it to be working, but when you send
it to a collaborator, they may find it to be broken, as they are testing it in a DAW. So always be
careful when using MIDI with GUI Core Cells.

Notes on Panel Elements

Similar to MIDI Events, the Events from Panel Elements can be from either the Audio Thread or
the GUI Thread depending on how the Panel Element was used.

» Events from Panel Elements that were generated by mouse or QWERTY keyboard interaction
will be generated in the GUI Thread.

+ Events from Panel Elements that were generated by MIDI, OSC, or Automation control will be
generated in the Audio Thread.

And so, just like with MIDI Events, it is important to make sure your GUI Core Cells will work in
both scenarios.

Note that the MouseArea Module, which only sends signals from direct mouse interaction, is one
of the few Panel Elements Modules guaranteed to send valid GUI Events.
Creating Valid Events with the Value Module

If you wish to connect an invalid signal, or a signal from a source that is not guaranteed to be from
the GUI Thread (for example a Knob Module), you can “re-clock” the signal to the GUI Thread by
using the Value Module and the Display Clock.
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A Structure for Attaching an LFO to a GUI Core Cell

9.4. New and Updated Modules

9.4.1. Structure Comment Module

The Structure Comment Module is a Module that allows you to annotate your Ensemble’s Struc-
ture. It appears as floating text within the Structure View of REAKTOR.

The Comment Module is located in the Auxiliary section of the Built-In Module submenu.

The Comment Module

. Double-click on the Comment Module to edit the Comment text.

3

When unselected, the Comment will appear as floating text in your Structure.

—=n ['l‘] Out »—s Out H
H -

A Comment in the Structure View

Comments automatically resize vertically to display all of the text, but you are able to define the
width manually:

*  Click and drag on the Comment’s edge to resize it.
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Comments are currently only available in the Primary level of the Structure; they are not available
inside Core Cells.

9.4.2. Anti-Alias Line Objects for Multi Display and Poly Dis-
play
The Multi Display and Poly Display Modules now have two additional object types:

* Object value -5: Anti-aliased line from (X1,Y1) to (X2,Y2)

» Object value -6: Anti-aliased line from (X1,Y1) to (X1,Y1) of the next object.

If you are familiar with the Multi and Poly Displays, then you will notice that these are duplicates of
the line objects, but with anti-aliasing.

Anti-aliasing smooths the lines, making them less pixilated.

The Same Display Using Anti-Aliased Lines

With Anti-aliasing, a new input port has been added to the Multi and Poly Displays:

* LW (Line Width): defines the pixel width of an anti-aliased line.

9.4.3. System Info Updates

The System Info Module has been updated with a new output port and a new property option.
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CFLU &
GUI

Systermn Info

The System Info Module

GUI Port

The new GUI Port outputs the load on the GUI Thread as a percent.

This port can be used to measure the performance of GUI Core Cells and Panel elements.

CPU Statistics

A new option in the Function tab of the Module’s Properties lets you define how the CPU load is
measured.

Function Info

S5TA

QUTPUT

Cpu Statistics

The New System Info Properties

» Smoothed: the CPU measurement will be averaged over small periods of time, giving you a
general measurement of CPU performance. This option produces more readable results, but is
less accurate.

+ Raw: the CPU measurement is constantly updated with the precise CPU load at that time. This
option is more helpful when searching for CPU peaks, but is difficult to read without additional
processing.

9.5. General Updates

9.5.1. Usage Data Tracking

REAKTOR tracks anonymous usage data and sends that data to Native Instruments so that they
can improve future updates by seeing which features are most often used and in which environ-
ments REAKTOR is most commonly used.

Usage Data options are located in the Preferences dialog.
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Usage data

Yes, enable usage data tracking

The Usage Data Tab of the Preferences Dialog

» In the Usage Data tab, click on the Read More... link to be directed to the Native Instruments
webpage with more information on Usage Data tracking.

* You can opt in or out of Usage Data tracking by clicking on the checkbox labelled Yes, enable
usage data tracking.

Data Being Tracked

The following data will be transmitted by Usage Data Tracking:

+ System profile (your Operating System, Audio Drivers, etc)
 Current location (country and city)

» Data about your interaction with the software (e.g. actions you perform or audio interfaces you
connect)

Data Not Being Tracked
The following data will not be gathered by Usage Data Tracking:

» Personal data (Name, email address, payment details, serial numbers, etc.)
» User content (file names being referenced, samples, songs, tags, comments, mappings etc.)
* Any user activity outside of the NI application
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10. REAKTOR 6.0

The following new features and changes have been added to REAKTOR 6.0.

10.1. New Look and Feel

REAKTOR's user interface has been completely reworked with a new look that provides better vis-
ibility of all elements. Most controls and options remain in the same place, so the overall layout of
REAKTOR 6 will look familiar to REAKTOR 5 users. The following section provides an overview
over the most important changes in the user interface.

10.1.1. Updates to the Side Pane

Updated Properties View

The Properties view has been updated to have a more uniform layout across all objects.

Information about the Properties can be found in the REAKTOR 6 Diving Deeper
document, as well as the Building in Primary and Building in Core documents.

Updated Browser

The File Browser has been updated with a new design similar to the one used in other Native In-
struments products.

Information about the Browser can be found in the REAKTOR 6 Getting Started
document.

Controllers and Panelsets Tabs Separated

The Controllers tab is no longer a sub-tab in the Panel Control tab.

Information about the Controllers and Panelsets tabs can be found in the REAKTOR
6 Diving Deeper document.

10.1.2. Updates to the Structure View

The Structure View in REAKTOR has undergone a large redesign with many updates that en-
hance usability and readability:
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* New color scheme.

» Wires now change color depending on their signal type.
» Anti-aliased wires.

* New icons for Macros and Core Cells.

» Optimization of the main context menu.

Additionally, users can now choose from a selection of four different color schemes and the ap-
pearance of Instruments and Macros has been improved with the new Flexible Look option.

@ In addition to the following section, information about the Structure View can be
found in the REAKTOR 6 Diving Deeper document.

Color Scheme

It is now possible to change the color scheme of the Structure View from the Preferences Window.

Mumber of undos

Computer K ard MIDI Channel

Structure Theme
Reaktor & Standard
Reaktor 5
Dark Grey
White

The Structure Theme menu in the Preferences Window.

There are four options available:

* Reaktor 6 Standard: The new default color scheme.

Panel
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» Dark Grey: A darker variant of the Standard color scheme.

Typ #———— Typ

* White: A bright color scheme with white Modules and Macros.

Etln

PHY
CH
HH

5,8
H1
HH

The Reaktor 6 Standard option is selected by default.

Appearance of Instruments and Macros

Ensembles, Instruments, and Macros now have a new Look property for their appearance in
Structure View.

Look

| I: [:] r Flexible
v Compact
MEES k_

The Appearance menu in a Macro's Properties.

This property has two options:

+ Compact: This is the standard look as known from REAKTOR 5.

* Flexible: This new look allows for more flexibility in the way the Ensemble, Instrument, or Mac-
ro is displayed in the Structure. It lets you give longer names to Ports, and larger icons to Mac-
ros and Instruments.

In

FMaod Out =
In
Pod ®° o

Bento Box VEA 1]

Bento Box VA El

The same Instrument displayed with Look set to Compact (left) and Flexible (right)
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10.2. Updates to Building

10.2.1. New Macro Libraries

The Macro Libraries for both Primary and Core have both been completely redesigned and rebuilt.
In both cases the new libraries have been designed to offer better tools and building blocks for cre-

ating your own Instruments.

@ Information about the Macro Libraries can be found in the REAKTOR 6 Building in
Primary and Building in Core documents.

10.2.2. In-place Editing

It is now possible to edit the names of Modules and Macros from the Structure View, without enter-
ing their Properties. This also applies to the value of Constant Modules as well as the names of

QuickBuses and QuickConstants in Core Cells.

1. Double-click on a Module or Macro's label to rename it from the Structure View.

2. Double-click a Constant to edit its value from the Structure View.

o,
o

‘ K Ny
T

* Double-click a QuickBus or a QuickConstant to rename it from the Structure View.

1 #—1
G 041 G 041

G—=5

smpl=D [?] ® Sample Size|

10.2.3. Panel Editing

A new option has been created that allows you to bypass the 4 pixel grid when editing the panel of
an Instrument or Ensemble. This way, you can move and resize panel elements with 1 pixel accu-
racy. This option is found in the Settings menu and is called Snap to Grid.
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&. REAKTOR

File

Edit : -
Settings Sample Rate
Options Control Rate
View

Macro

Function

Store Panelset
= — Recall Panelset
Wlano

+ Automatic Panel Layout
+ Snap to Grid

Mute
- - Sync to External Clock h‘
Enable Send Clock to MIDI Output

Set BPM by Snapshot
APPEARAMNCE by =

Turn off Reaktor 4 Legacy Mode

l::|:|l'|'||:|E||I[ v

The Snap to Grid option in the Settings menu.

@ Information about panel editing can be found in the REAKTOR 6 Building in Primary
document.

10.2.4. Table Framework

Table References are a new signal type in REAKTOR 6. They allow flexible and efficient sharing of
data in the structure.

A table is a two-dimensional array of data, and Table References allow you to access this data
anywhere in the structure. These properties make the Table Framework ideal for working with
samples.

Core Cells read tables from a Table Reference like they have always handled tables and arrays.
The advantage is that a Table Reference can exist in the Primary level, thus it can be used to
share data between Core Cells, and can be stored in a Snapshot.

The Table Framework also makes the following possible:

« Sample information can be sent from the Sample Map to a Core Cell as a Table Reference.
» Drag and drop of samples onto the Instrument/Ensemble Panel.

@ In addition to the following sections, information about the Table Framework can be
found in the REAKTOR 6 Building in Primary document.

10.2.5. New and Updated Primary Modules

Table Framework: New Modules

The Table Framework has introduced 3 new Modules:
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Table List

® Sel

Table List

The Table List Module

This module is the main table manager and lets you maintain the list of currently active tables. It is
the only table reference module with Snapshot support.

Table Info

Table Info

The Table Info Module

The Table Info Module is used to read out a table’s meta-information such as size, number of
channels, sample rate, loop points, etc.

Sample Map

Sarnple FMap

The Sample Map Module

This Module is a lot like the Sampler Module, but outputs a reference to the sample table, rather
than the audio from the sample. In practical terms, this Module allows you to take sample data
from the Sample Map and send it into a Core Cell.

Table Framework: Changes to Existing Modules

A number of Modules have been updated to accept the Table Reference signal type:

* Merge

» Order

* Routers (all types)
+ Value

+ Switch

* To/From Voice

27 What Is New



REAKTOR 6.0

Mouse Area

The Mouse Area Module has undergone the most changes with the introduction of the Table
Framework.

The Updated Mouse Area Module

It can now accept the dragging and dropping of samples into the Table List. As such it has been
given a number of new inputs and outputs for this:

* Inputs
* *Dgl (Drag Input): Connect a Table Reference here to use the Module as a source for drag
and drop.

* DpA (Drop Accept): A value of 1 or greater at this input tells the Module to accept Table
Reference drops.

* Outputs

» DpO (Drop Over): Outputs a value of 1 when a Table Reference is dragged over the Mouse
Area; outputs a 0 otherwise.

* DpG (Drop Gate): Outputs different values depending on the drag and drop state: A value
of 2 is sent when a file is dragged over the Mouse Area, followed by a 0; a value of 1 is sent
when a file is dropped on the Mouse Area (if the DpA input is set to 1 or higher), followed
by a 0.

* *Dp (Drop Output): Outputs the Table References that are dragged and dropped on the
Mouse Area.

Panel Modules

Width and Height Outputs

Several Panel Modules have been updated to include two new outputs that send the value of the
Module's Width (W) and Height (H) on the Panel.

These ports have been added to the following Modules:

* Mouse Area
» Poly Display
+ Multi Display
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Fonts

Both the Text and Multi Text Modules have been updated to include additional font options, includ-
ing:

* Font Typeface: There are nine font types to choose from, illustrated below.

| Legacy

Condensed Light
Condensed Bold
Light

Bold
Extrabold

|
| |
| |
| |
| Regular |
| semibold |
| |
| |
| |

Monospace

+ Choose Font Color: Font color can be selected using the same pop-up window used in the
Instrument/Ensemble Color Scheme Properties.

* Font Size (Pixels): Sets the font size. This option is disabled for the Legacy font.

Information about the Panel Modules can be found in the REAKTOR 6 Building in
Primary document.

10.2.6. New Additions to Core

The following is a very brief overview of the main changes to the Core building language.

In addition to the following sections, information about Core can be found in the RE-
AKTOR 6 Building in Core document.

Unified Core Cell

Core Cells are no longer divided into Audio and Event; there is now only one type of Core Cell.
Like the old Audio Core Cell, the new Core Cell can accept both Audio and Event signals as in-
puts, but the new Core Cell can also output both Audio and Event signals.

Bundles

Bundles are a method of combining multiple wires into one. Wires can be packed into a Bundle
and then unpacked into the individual wires later on.
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Core Bundles.

Scoped Bus

Scoped Buses allow 'wireless' connections between several structure layers. Scoped Buses can
also send Bundles between different parts of the structure.

Sample Rate and Control Rate Clocks

The Sample Rate is no longer treated like a QuickBus, but is instead bundled with its clock as a
Standard Distribution Bus.

The Sample Rate Bundle using Scoped Buses.

A Control Rate clock is also included as a Standard Distribution Bus, giving you a separate clock
for event signals. However, by default this clock is set to be the same as the Sample Rate, so it
needs to be defined.

10.3. GUI Core Cell

In REAKTOR, Event and Audio signals are both processed in the Audio Thread, so if you created
a Core Cell to process Mouse Area Events to manipulate a Multi Display, all of those calculations
would happen in the Audio Thread.

The GUI Core Cells move their processing from the Audio Thread to the GUI Thread. This lightens
the load on the Audio Thread, leading to better performance overall.

To create a GUI Core Cell:

Create a Core Cell as you would normally.
Enter the Structure of the Core Cell.
Navigate to the Function tab of the Core Cell’s Properties.

b=

Check the GUI Event-Only option (if the option is not visible, click in an empty space in the
Core Cell’s structure to make it visible).
Core Cell

Function  Info

Default @

FUMCTIOMN

GUI Event-Only
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The Core Cell is now a GUI Core Cell, and will be processed in the GUI Thread.

Tenal
Core Cell

A GUI Core Cell

GUI Events

GUI Core Cell will only accept GUI Events, and will ignore all other Event and Audio signals.

GUI Events include:

* Any Event produced via mouse interaction, for example: the user interacting with the Mouse
Area module.

» Events produced from the DClk (Display Clock) output of the System Info Module.
+ lteration Events that were triggered by the Display Clock.
* Init Events, for example: Events from Constant Modules.

The following Events will be ignored by the GUI Core Cell:

» Event signals from Modules other than the System Info DCIk.
» Event signals from regular Core Cells
* All MIDI messages.

» Event Signals from Panel elements that do not come from mouse interaction (for example: an
automated Knob)

If you wish to use an Event Signal that is not a GUI Event, you can use the Display Clock and a
Value Module to “re-clock” the signal.

!;;;l_mt

CF

GUI

R

—aF

*——=aH Si
| .

®5nc

- HHH L
' EZmmE aaro

*Fh

Using the Display Clock to create GUI Events from an LFO
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